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1. f§fid

Quartus Il /& Intel (J& Altera) AR [IZEE 1% PLD/FPGA FF R AT, 1EN—Fhn]4mfeiZ
BBEIAEE, BT BRI RITR MBS R, BB T EEDR, FHg—, o)
Rederh, S5 o SRR AL, BB 237 RG T I

>  AIFFJEFEE. Z5HIHEE]. VerilogHDL. AHDL 11 VHDL 52 A HLER IR, I HARAE

VLV AR S A

> CEFRE ALTERA [ 1P #%, T840 T BT A2, bl 7 8-

> A SignalTap I 4874 T HFAT IR A HZ 4 75 Hr

HHF Windows &45, Linux RGUF1 Unix &40, 34t T 52800 P A mvei- 77 2.

2. B

2.1 Quartus Prime 34 T #:

1. 4T7F Intel-Altera B, #F| Quartus RV 230 T EOUR, FER 3.
> Intel-Altera B ¥
https://www.altera.com.cn/
> B EG:
https://www.altera.com/downloads/download-center.html
> ERAIRARERAE RS, [FIRA)3E Quartus Prime. ModelSim-Intel FPGA Edition
HMAX 10 R VI3 HF

M select All
[*]Quartus Prime Lite Edition (Free)

[v]Quartus Prime (includes Nios Il EDS)
Z: 1.7 GB MD5: EEBAOE3703C46C806FE7A61E5868DEQE

[¥*IModelsim-Intel FPGA Edition (includes Starter Edition)
A7 : 1.1 GB MD5: 81EAE2F2D55ABECDAF1265FCDFET4760

M Devices
A E LD — -SRI RS T H A AQuarus Primed .

[C]Arria Il device support
X/~: 400.6 MB MD5: 77E151BBF3876F6110ABOAF7C6A68047

[Icyclone IV device support
#: 466.7 MB MD5: 70A27B31D439D6271650C832A9785F2C

[Icyclone V device support
A : 1.1 GB MD5: 8386E6891D17DC1FAF29067C46053FC7

CIMAX 1I, MAX V device support

#4: 11.4 MB MD5: AFCBFFO69FBAG3ES84D5DA0AES1 2F83A2
[*IMAX 10 FPGA device support

#4: 331.3 MB MD5: 013AACB391EAD32FFS8E094DOD14987C3

2. MR¥E AR RT3


http://baike.baidu.com/view/3317625.htm
https://www.altera.com.cn/
https://www.altera.com/downloads/download-center.html
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2.2 Quartus ZEEP

1. R RSO RE R SRk b, SCfFInTR . XEHEAT QuartusLiteSetup S

e &@==]

R HRRE =S
HHr  BAEE -
o TEE
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=1
B sen
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& 5%

18 B
&, i ()
o TR (D)
o BHREE (F9

TR #EEH)
HE ~ ET=

| D

1.0.196.qd
z

m

rnax10-16.

@Q'| Lo MEIL » EHERGE (D) » SR » Alterafifbi

=

ModelSim
Setup-16.1
L1196 -win
dows.exe

-4 |[ = beratiire P

= 0 @

=

QuartusLit
eSetup-16.
1.0196-wi
ndows.exe

2. Quartus Jo s At 2 Ja H B 2238 38R i

_a Installing Quart

M1, s Next ZEANT—25,

Setup - Quartus Prime Lite Edition [Free) 16.1.0.196

Welcome to the Quartus Prime Lite Edition (Free) 16.1.0.196 Setup Wizard.

The Quartus Prime software requires that your system have sulfficient physical RAM to compile designs
targeting specific devices. You can check the "Memory Recommendations” section in the "Quartus
Prime Software and Device Support Release Notes" [https: /Awww. altera.com/support/literature/lit-
n.html) for detailed memory requirements for a particular device.

For more information about Intel FPGA software, go to http:/ fwww. altera.com.

< Back [ Next > ][ Cancel
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3. WEEFIREIIL, S Next EANT—2.

License Agreement

You can view the full license agreement at the link below or use -install_lic option from command-line to get the license agreement files
before the installation. You must accept the terms of the agreement before continuing with the installation.
http://dl. altera.com/eula

QUARTUS(R) PRIME LICENSE AGREEMENT YERSION 16.1 (WEB DOWNLOAD)

Copyright (C) 2016 Altera(R) Corporation. Altera, Quartus, Nios(R) Il
and the Altera logos are trademarks of Intel Corporation or its
subsidiaries in the US and other countries. Any other trademarks and

trade names referenced here are the propery of their respective
OWners.

Certain files, programs, or other materials provided in connection
<

m

s | accept the agreement
Do you accept this license? e
() | do not accept the agreement

InstallBuilder

4.

Installation directory

Specify the directory where Quartus Prime Lite Edition [Free) 16.1.0.196 will be installed
Installation directoryl D:AintelFPGA,_lite\16.1 I

InstallBuilder

[ < Back ]I Next > l[ Cancel ]
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5. WA, WTE, AEXTRAIHEM, S Next #EAT

|
Select Components ( inte')
Select the components you want to install
& Quartus Prime Lite Edition (Free) ‘You can add additional device support to an existing
Quartus Prime (includes Nios Il EDS) [7110MB) Quartus Prime software installation without having to
=2 Devices reinstall the entire software package. Use the Install
I MaX 10 FPGA (341.9MB) Devices command on the Tools menu in the Quartus Prime
- [7] ModelSim - Intel FPGA Starter Edition (Free] (3371.5MB) software to get started.
[7] ModelSim - Intel FPGA Edition (3971.5MB) ; ;
Select a component for more information
|
|
|
|
InstallBuilder
[ < Back ] [ Next > ] [ Cancel ]

.

6. JEH i Next #EN Quartus BPFH B35, KATELADN SR, B2
Quartus 44, Modelsim #AFF1 MAX R 51154 S e 4 223 .

3 Installing Quartus Prime Lite Edition (Free) 1

Installing i I‘Ite|)
Wait while Setup installs Quartus Prime Lite Edition (Free] 16.1.0.196
Installing
Unpacking files
- ——
InstallB uilder 5
<Back || MNext> | Cancel
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7. H 323 58 it N\ 2235 58 i A, /2035 “Launch USB Blaster Il driver installation” 1 “ Create
shortcuts on Desktop” W5, midi “Finish” %4,
Installing Quartus Prime Lite Edition (Free) 16.1.0.1'

Quartus Prime Lite Edition [Free) 16.1.0.196 Installation Complete

Setup has finished installing Quartus Prime Lite Edition [Free] 16.1.0.196.
IEZ] Launch USB Blaster |l driver installation l

[V] Create shortcuts on Desktop
[7] Launch Quartus Prime Lite Edition
[ Provide your feedback

< Back Cancel

8. M bR, B IKAIRE R A S U R, M Next EA R —20
EERNEFEEAS

AR R E RIS

It SEE BT T R IR EhiE Fr - (R RIXEIRENE
e s L = :

FBHE, FRET—H" -

< F—EE =50 > [ BE ]
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7] Windows 22 =)

AL EXANZ G D?

EFR: Altera
Z75E: Delaware Altera Corporation

] #£85ITEE "Delaware Altera Corporation” 3 =20 AZE(N)
PUE(A).

W SRS AHEEENETRY.

10, Wil A Zh 2R B A RE e, SeSOE S A, sy “SE” Wk

EERNEFEEEAS

IEfER AR FREIZF RS

HHE, ERRThiETEE T HARENE R
ﬂgjﬁa&%i&%iﬂ%@l&tﬁﬁﬂ o WNR G EFIFIHER,
Gk -

SEENIE R #7s
N Altera (#inUSB) JT... BILI#ERET

<r—$®|C =k ) [ mE ]

11. 8¢5 3 H Quartus B4 F 2% 52 B TR T, 20 3% Run the Quartus Prime softwave ” &t OK”
SERERAER) 2285, [EIRT Quartus #LFR ), A s 2 B,

Thank you for installing the Quartus Prime software - the #1 in performance and productivity. To

upgrade to a full featured edition, please visit www.altera.com.

Select one of the following licensing options to continue:

Select one of the following options

(") Buy a Quartus Prime software license

@ Run the Quartus Prime software

(") Add an IP license file (for users who have purchased IP)
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3. GIEE— LR

3.1 HrEaTHE

1. Ja3h Quartus #f4:

Xt Quartus RYVEHAFERR, FHan T~ (L Quartus 11 15.0 1)

€4 Quartus 11 64-Bit - m] X
File Edit View Project Assignments Processing Tools Window Help -] @
EEEINEYT RS AR L L I AT T L P
Project Navigator x| H Hame B8 1P Catalog e x|
Q, x ~ Device Family Cydone V (E/GX/GT/SX[SE[ST) -
Start Designin -
sy Compilation Hierarchy 9 9 Q 9 | =
v & Installed P -
¥ Project Directory
Mo Selection Available
&Hierarch‘,I é Files & Design Units 5 4 » New Project Wizard Open Project ~ Library
Tade g x | > Basic Functions
- > Bitec
Flow: |Compilation ~* | | Customize... i ‘_7 LrﬁJ\ o . ‘ » DSP
Task ~ - > Interface Protocols
~ B Compile Design . > Memory Interfaces and Controllers ©
P v Recent Projects
< > . w oGP Add..
X
allan |8 A A e |T s<Fiters FAEind... | 44 Find Next
1
Type ID Message
il
3
il
=/\_system /\_Processing /
0% 00:00:00
=
2. BIZETRE:
. . . Ny 3 . . =1 4=
Fii7 File—New Project Wizard &1 8¢ it Home T " [ New Project Wizard Kl #5.
€4 Quariys 11 64-Bit - m] X
File™ Edit View Project Assignments Processing Tools Window Help -] @
boe= i Y - #%9e 0 ren DO EL QRA @
5 open.. BT El H Home B8 IF Catalog LY-F3
Close Cirl+F4 b 4 ~ Device Family Cydclone ¥ (E/GX/GT/SX/SE[ST)
] NewProject Wizard... ——  Start Designing a X| =
Open Project... Ctrl+3
G OpenProl \ v & Installed P -
Save Project v Project Directory
SrmEEE Mo Selection Available
Save Crl+s \ﬂll New Project Wizard Open Project ¥ Library
Save As... g x > Basic Functions
G saven Clrl+Shift+5 — 7 itec
mize... Qy Lrﬁj\ o . o > DSP
File Properties... ~ = > Interface Protocols
o > Memory Interfaces and Controllers v
13 =
Tmnizas v| Recent Projects
Export... > . v | e Add...
Convert Programming Files. ..
&4 Find... | @ Find Next
@ Page Setup...
|4, Print Preview
=) Print.. ctri+p
Recent Files 3
Recent Projects 3
0% 00:00:00

3. THEHZ. WIES: (E&: LREAXPARADGE. THRETRD)
> LREHZ: SO TR HX
> LREARR: HETRAK
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> TRBRAFR: Bk top module FIREERAFR, BAFER IR LA 4 FRAH A

&4 Mew Project Wizard

x

Directory, Name, Top-Level Entity

What is the working directory for this project?

I F:/LED_shining I
What is the name of this project?

| LED_shining |
Whiat is the name of the topdevel design entity for this project? This name is case sensitive and must exactly match the entity name in the design
file

|LED_shining |

Lise Existing Project Settings...

< Back Finish Cancel Help

4\ I%ﬁ‘f%’éﬂ:
1% Empty project, i Next.

&4 New Project Wizard

Project Type

Select the type of project to create.

Em|:|t5-I project

Create new project by spedifying project files and libraries, target device family and device, and EDA tool settings.

() Project template
Create a project from an existing design template. You can choose from design templates installed with the Quartus II software, or

download design templates from the Design Store.

< Back Finish Cancel Help
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5. #INSCAt
SR CAT BT SO, AR AT DU E BTN, il Next.

&4 New Project Wizard >
Add Files
Select the design files you want to indude in the project. Click Add All to add all design files in the project directory to the project.
Mote: you can always add design files to the project later.
File name: I“le Add
File Mame Type Library Design Entry/Synthesis Tool HDL Wersion add all
Remove
Up
Down
Properties
Specify the path names of any non-default libraries.
| < Back | I Mext = I | Finish | | Cancel | | Help

6. ik F:
R4 T T G A8 FH I FPGA L HEX] B4 (10M02SCM15317G),  Kiili Next.

&4 MNew Project Wizard

Family & Device Settings

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus II software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in "Available devices' list
Family: |MAX 10 (DA/DF/DC/SA/SF/SC) / ~|  Package: [mBGA -~ -
Devices: |MA)< 10 5C \ - | Pin count: |153 - - |
Target device Core Speed grade: |? etff— - |
Auto device selected by the Fitter Mame filter: | |
(@ Spedfic device selected in "Available devices' list Show advanced devices
Other: nfa

Available devices:

Name Core Voltage LEs Total If0s GPIOs Memory Bits Embedded multiplier 9-bi
110522

1
10MO45CM153I7G 3.3V 4032 112 112 193536 40
10MOB5CM153I7G 3.3V 3064 112 112 387072 43
< >

< Back | I Mext = I | Finish | | Cancel | | Help
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7. EDA T Hik#:

RS =77 EDA T H: WRAFELUERFH =g asifiE TR
A IR IR E R SRR, X BIRATIE LA modelsim T HA5 ¥,

(=LA
A Next.

T

&4 New Project Wizard >
EDA Tool Settings
Specify the other EDA tools used with the Quartus II software to develop your project.
EDA tools:
Tool Type Tool Name / Format(s) Run Tool Automatically
Design Entry/Synthesis | <Mone> - || <MNone > Run this tool automatically to synthesize the current dg
Simulation ModelSim » | Verilog HOL » [] Run gatedevel simulation automatically after compilatio
Formal Verification <MNone> \
Board-Lewvel Timing <MNone > -
Symbaol <Mone = -
Signal Integrity <Mone = -
Boundary Scan =Mone >
£ >
< Back Finish Cancel Help
imByA% >
8. LIEBEII:
\)—L & . .
AN AR i B, W75 % S Back IRIFME M, #HHIINIXE, s Finish,
& New Project Wizard Pt
Summary
When you dick Finish, the project will be created with the following settings:
Project directory: F:\LED_shining
Project name: LED_shining
Top-evel design entity: LED _shining
Mumber of files added: 1]
Mumber of user libraries added: a
Device assignments:
Design template: njfa
Family name: MAX 10 (DA/DF/DC/SAJSF/SC)
Device: 10M0O25CM153I7G
EDA tools:
Design entry/synthesis: <Mone > (<Mone>)
Simulation: ModelSim (Verilog HDL)
Timing analysis: 0
Operating conditions:
Core voltage: 3.3V
Junction temperature range: -40-100 =C
< Back Mext = Cancel Help
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9. LFEAIEESEEE, Quartus B HEIHENTF R A, 05

€4 Quartus |l 64-Bit - F/LED _shining/LED shining - LED shining

O X

File Edit View Project Assignments Processing Tools Window Help =2 O
Degd @ 4 5@ 9 o |[Epshing MY SO D eI G0 2SR A 0@

Project Navigator nax| 1P Catalog nax|
a x [a x| =
Entity v & Installed P -

Ay Max 10: 10M025CM 153176
< LED_shining 5'@1

“ Project Directory
Mo Selection Available

~ Library
Ay tierarchy | [E|Fles &P Design Units > Basic Functions
> Bitec
Tesks > DSP
Flows |Conpiation - | [cusonize... > Interface Protocols
Task > Memory Interfaces and Controllers
O Documentation > Processors and Peripherals

~ = Compile Design
R V. T O Notification Center S Add...

al (@ [® <<riter>>

Type ID Message

~

A X

\i) 253020 Default device 10MOBDAF484C7G is automatically selected for the device family MAX 10

Messages

System (1] Processi

3.2 3
1. 1%EF¥ File—New B{ fidh THEAZHH New #4l, E#¥ Verilog HDL File SCHFRAY, ridli OK,
Quartus K2 H @ HATHF Verilog XX

& Quartus Il 64-Bit - F/LED shining/LED _shining - LED shining — [m] #

File Edit View Project Assignments Processing Tool & New x e
2@ 9 o ] gl LIk
.E Hd £ 9c e Mew Quartus T Project PR OO0 L SR A 0

0% 00:00:00

Project Navigator o@x| “ Design Files IP Catalog 18 x|
AHDL File —
) X Black Diagram/Schematic File ‘ Q X ‘ =
EDIF File
Enti v ~
ty Gsys System Fle &2 Installed TP
/iy MAX 10: 10MOZSCM15317G State Machine File v Project Directory
% LED_shining & SystemVerilog HDL File Mo Selection Available
=] ile
v L
Hrary
Ay Hierarchy E| Files # Designunits ~ “%, 4| WHDL File » Basic Functions
“ Memory Files Bitec
Tasks e x| Hexadecimal {Intel-Format) Fie
Dsp
- Memory Initislization File
Flow: |Compllahon = | | Customize... |

v Verification/Debugging Files

>
>
» Interface Protocols
b
»

In-System Sources and Probes File Memory Interfaces and Controllers
Task ~ . "
Logic Analyzer Interface File
- y Processars and Peripherals
v B Compile Design SignalTap II Logic Analyzer File "
— . . hd University Program VWF
< > ~ Other Files & Add

= AHDL Indude File
y Block Symbol Fil
s/a @ (CIRETEEEN et

Synopsys Design Constraints File
Typs ID  Message Text File bt

@ 253020 Default device 10MOSDAF48 I

oK ” Cancel | | Help | Ehe device family MAX 10

Messages

System (1) Processi

0% 00:00:00

2. TEHTEN Verilog SCAH1 31T Verilog HDL ARAS9m 5 « {R1F, XAF4 4 LED shiningv, WI'F
KRR, FEFEEE.
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“4 Quartus |l 64-Bit - F/LED shining/LED shining - LED_shinin, —
g g . =] . =]

O x

Fie FEdit View Project Assignments Processing Tools Window Help 5 [searchaleracom | @

DS @ % 5o @ 9 o] [LED shinng Y S¢S0 D ren D0 ER P A 99
Project Navigator Aax] 4 LED_shining. v ¢ 1P Catalog o8 x|
O L= =
3 X @ asd==0fTam 08 2> x| =
[ Fies ; E|n(’.od'.lle LED shining Al v 2 staled N
b i - .
LED_shi £
st 3 |imput clk_in, //clk in = l2mhz ' Project Directory
4 input rst_n_in, //rst_n_in, active 1 Mo Selection Available
5 output ledl, //ledl output v Library
= B [ output led2 //led2 output : 5
My Hierarchy  [E| Files " Design Units S L > P 2 34 Basic Functions
= ’ Bitec
Tasks LEFY
g paramecer CLK_DIV_PERTOD = 12 0 DsP
Flow: |Compilation ¥ | | Customize... | | 10 Interface Protocols
| == Teg clk div=o; Memory Interfaces and Controllers
Task 12 4 heral
i . Processors and Peripherals
~ = Compile Design 45 S/wire ledl, ledz; v
- - - . R V|14 assign ledl = clk div; hd
< > < > 4 Add...
x
= A |8 A (A A |© < <Filter > G4 Find... | |3 Find Next
It
Type ID Message £
\i) 21057 Implemented 54 device resources after synthesis - the final resource count might be different
8 \I) Quartus II €4-Bit Analysis & Synthesis was successful. 0 errors, 0 warnings "
2| < >
i
=|\_System (1] Processing (10]
100% 00:00:36

(e LER

module LED shining

(

input clk in, //clk in = 12mhz

input rst n in, //rst n in, active low
output ledl, //ledl output

output led2 //led2 output

)

parameter CLK DIV PERIOD = 12 000 000;
reg clk div=0;

//wire ledl,led2;
assign ledl = clk div;
assign led2 = ~clk div;

//clk div = clk in/CLK DIV PERIOD
reg[?Z:C] cnt=0; B B
always@ (posedge clk in or negedge rst n in) begin
if('rst n in) begin
cnt<=0;
clk div<=0;
end else begin
if (cnt==(CLK DIV _PERIOD-1)) cnt <= 0;
else cnt <= cnt + 1'bl;
if (cnt<(CLK DIV _PERIOD>>1)) clk div <= 0;
else clk div <= 1'bl;
end
end

endmodule

3 IEFESEHFE T Processing— Start—Start Analysis & Synthesis T &% T H A% Start Analysis

& Synthesis %41, 0~ E TR,
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€4 Quartus 11 64-Bit - F:fLED}hining;’LE%hining - LED _shining - O x
Fie Edit View Project Assignments | Processing  Tools Windaw Help & @
|_1 E =] ﬂ ¥ By m 9 L/ Stop Processing Ctrl+shift+C 3 @ el 5 6 0 "1.5 Q: ‘9 % i!* @ )
Project Navigator = Start Compilation Crl+ 1P Catalog LY-F3
Q B/ Analyze Current File |B‘ s @ 3 |J\h X =
& Files — Start » P2 StartHierarchy Elaboration A
LED_shining.v Update Memory Initialization File %y  Start Analysis & Elaboration
».9 Compilation Report Cirl+R _-,.g Start Analysis & Synthesis Cirl+K
».9 Dynamic Synthesis Report 5, StartPartition Merge
(B Hierarchy Files o DesignUi ;
5? PowerPlay Power Analyzer Tool ﬁ Elathtay
Tass T S5M Analyzer Tool &) SElm=Tn
Flow: | Compilation o | . & Start TimeQuest Timing Analyzer Ctrl+Shift+T
Receive Compilation Status Notifications ,é]- Start EDA Netlist Writer L .
Task = Controllers
as! 12 #§ startDesign Assistant .
- . o : erals
P Compile Design 43 //W‘}IE ledl, led2; ~ 'y Start PowerPlay Power Analyzer Ctrl+Shift+P v
7 > B an |l 1% assign ledl = clk_div
_ fosiom s-am = —a% | BF  StartSSN Analyzer
< > <
= K Start Rapid Recompile
oA | A |4 A | T <<Filter>> 34 Fin
1 %7 Start SignalProbe Compilation Ctrl+5hift+1
Type ID Message EE Start I/O Assignment Analysis ~
- \Q 11104 Parallel Compllation has detected 4 hyper-threaded pr @ Start Check & Save All Netlist Changes ded processors will
il v
&
g« Start VQM Writer 2
=|\_System (1] i
EEu Processing (4 Start Equation Writer {Post-synthesis)
Analyzes and synthesizes all of the files in the hierarchy of the current top-evel entity s . 4% 00:00:32

4. Quartus BT TR E, HRIHEE -, 2546 Tasks £=H1 Analysis & Synthesis 4=
AR, R A AR 2] . 7] L% FE Tools— Netlist Viewers—RTL Viewer 55 HLI .

€} Quartus |l 64-Bit - F/LED shining/LED_shining - LED _shining - O x
File Edit View Project Assignments Pru:ess\ns Tools  Window Help =2 @
DS @ % 5@ 9 o ||[Epshinn  RunsimiatenTool P D rn 00 2 @9 A e
» . N - =
Project Navigator na Launch Simulation Library Compiler Loort - LED, shining [ 1P Catalog ngx ‘
Launch Design Space Explorer I
2 = &0 05 22 x| =
A =
[ Files (5§ TmeQuestTiming Analyzer ~l v A reled .
LED_shining. Advisors [ ~ Project Directory
) _n_in, active 1 Mo Selection Available
&  Chip Planner utpuc ~ Library
% Hierarchy Fies  of DesgnUnits < 4 48 Design Partition Planner prput > Basic Functions
= Netlist Viewers —_— Viewer
Tacks 5 & RL
. " . Technology Map Viewer (Post-Mappin
Flow: | Compilation )| (e @] SignalTap I Logic Analyzer fﬁ s o poing) Protocols
@  In-System Memory Content Editor S Technology Map Viewer (Post-Fitting) e facme and Control
Task rfaces and Controllers
@ Logic Analyzer Interface Editor @ state Machine Viewer d Peripheral
~ B Compile Design @ e . and Peripnerals
n-System Sources and Probes Editor i v
L > B Analysis & Synthesis k— v > University Program
p N SignalProbe Fins... 3 5 S Add...
% Programmer
x
2l a8 |4 A A | T <<Fiter>> P ITAG Chain Debugger 44 Find Next
ka % Fault Injection Debugger
T ID M -~
ves =ssag= System Debugging Tools »
ol > @ Quartus II €¢-Bit Anal 0 errors, 0 warnings
= IP Catalog ¥
gl Fw id Tools for Ec 2
o Mios IT Software Build Toals for Eclipse
=|\_System (1] Processing (10; "
Opens the RTL Viewer S O5¥S 100%  00:00:37
5. RTL HLEREIAR
Equald
’ LessThan0 led1
25h5b8d80 E[24..0) led2~not
led2
di_in [ ent[24..0]
rst_n_in[_>»

3.3 BHZAR

1. 1% Assignments— Device ] 5 4-ic & ULIHI , 28 5 r. o DA # HY Device and Pin Options:++
G IGFT T S A FH T A% T DL T
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&4 Device X

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus II software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in "Available devices' list
Family: |MAX 10 (DA/DF/DC/SA/SF/SC) - Package: MBGA -
Devices: |MAX 10 5C - Pin count: 153 -
Core Speed grade: |7 -
Target device
Mame filter: |

Auto device selected by the Fitter

| Sh d d devi
(®) Spedfic device selected in 'Available devices' list oW advanced devices

Bos s —-"|Devi0e and Pin Options... |

Available devices:

Name Core Voltage LEs Total I/0s GPIOs Memory Bits Embedded multiplier 9-bit el
10MO2SCM15317G 3.3V 2304 112 112 110592 32
10MO4SCM153I7G 3.3V 4032 112 112 193536 40
10MO8SCM153I7G 3.3V 8064 112 112 387072 43
£ >

Migration Devices... | 0 migration devices selected

Cancel Help

2. {E Unused Pins &I L & Reserve all unused pins A As input tri-stated K7 .

&} Device and Pin Qptions - LED_shining *
Category:
Configuration
Programming Files Spedify device-wide options for reserving all unused pins on the device, To reserve individual
=P | inused Fins dual-purpose configuration pins, go to the Dual-Purpose Pins tab. To reserve other pins

Dusl-Purpase Pins individually, use the Assignment Editor.

;2:?;.?:;;0:::3 == Reserve all unused pins: | As input tri-stated -
10 Timing

Voltage

Pin Placement

Error Detection CRC
CvP Settings

Partial Reconfiguration

3. ff Voltage #£J [il & Default I/O standard A 3.3-V LVTTLARZS. #RJ5 OK [HI 2B Fi -

&} Device and Pin Qptions - LED shining *
Category:
General
Configuration
Programming Files Specify voltage options for the device.
Unused Pins
Dual-Purpose Fins == Default IO standard: |3.3~V LVTTL - |
Capaditive Loading B ) § ) ) .
Finard Trace Model VCCIO IO bank1 voltage: |mfa in MAX 10 — use Pin Planner to adjust VCCIO voltage e
1/0 Timing WCCIO L0 bank2 voltage: | nyfain MAX 10 — use Pin Flanner to adjust YCCIO voltage e
= Voltage
Pin Placement Core voltage: 1.2V
Error Detection CRC
CvP Settings
Partial Reconfiguration

3. IEFESEHEL P Assignments— Pin planner #£3 8¢ TH A Pin planner Elfx, HENE %
Hic A1
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4 Quartus 11 64-Bit - F;/LED_shining/LED shining - LED_shinin:
' g . 9 _: =]

— [}

x

Edits pin assignments

Fie Edit View Project  Assignments Processing Tools Window Help 5 Search altera.com @
o T, = 5 | S
DEEHP| % 5= b= e ¥ O ren G0 A 9L 6@
+*  Settings... Ctrl+5hift+E
Project Navigator = = gk Compilation Repart - LED_shining (] 1P Catalog pa x|
Q & Assignment Editor Ctrl+5hift+A R IR
&5 Files % Pin Planner Cirl+5hift#N | LED shining Al ‘% Installed P ~
a2d LED_shining. Remove Assignments. .. " -
= ) k_in, //clk in = l2mhz * Project Directory
i BadcAnnotate Assignments... t n in, //rst n in, active 1 No Selection Available
Import Assignments... edl, //ledl output ~ Library
Ay Hierardy  [E] Files Export Assignments. .. ed2 //ledZ output > Basic Functions
Tasks Assignment Groups... > Bitec
II r CLK DIV PERIOD = 12 000 000 > DsP
Flow: | Compilation 2 LogicLock Regions Window Alt+H 3 Interface Protocols
i Design Partitions Window Alt+D div=0; > Memory Interfaces and Controllers
~ B Compile Design 13 S fwire ledl,ledZ; 7 Processars and Peripherals
. — . i v
L > P Analysis & Synthesis v|| 12 assign ledl = Clk_dl‘_f' " 2_University Program
< > < > Sp Add...
x
& Al @l |? < <Filter >
1
Type ID Message S
wl| ¥ \D Quartus II &4-Bit Netlist Viewers Preprocess was successful. 0 errors, 0 warnings
2 v
8« >
]
=|\_System (1] Processing (14)
100% 00:00:07

4. 1F Pin Planner UL ] FH ¥ T A iy 11 43 FC 6T 2 1) FPGA BRI, a0 R B, AR5 5% M] CHBRAE) .

55 Pin Planner - F/LED _shining/LED shining - LED shining

O

X

&
e
&

<<new node >

All Pins

PIN 19

File Edit View Processing Tools Window Help 5 Search altera.com 6
@ EP"”: iax | Top View - Wire Bond
Report not available MAX 10 - 10M025CM15317G
L
)
O
"
Ji Groups Report
D | asks ogx| e
™ ~ [Z Early Pin Planning ~
] Early Pin Planning. .. e
¥ Run Ij0 Assignment Analysis
3 Export Pin Assignments...
iﬁ [ Pin Finder... v
= X Named:| = ~ ||<<>>| Edit: . | |PIN_39 |Fi\ber:|Pins: al -
=]
1 Mode Mame Direction Location Ij0 Bank VREF Group 10 Standard Reserved Current Strength Slew Rate

0%

00:00:00

5. &P AL Processing— Start Compilation #%10 B¢ T H A% Start Compilation %41, JF
BITA 9 1E, %54 Tasks SR T A IRTUER, N

» [ Analysis & Synthesis Total logic elements 51/2,304(2%)
> [ Fitte Total combinational functions 512,304 (2%)
reer Dedicated logic registers 262,304 (1%)
> [0 Assembler Total registers 26
- >
Y Hierarchy lg Files 4 Design Units " 1 PowerPlay Power Analyzer Total pins 4/112(4%)
> [ TimeQuest Timing Analyzer Total virtual pins 1]
Tasks 1&x | > [ EDA Netlist Writer Total memary bits 0/110,592 (0 %)
- . Embedded Multiplier 9-bit elements 032 (0 %)
Flow: |Compilation * | Customize... 1) Flow Messages -
o | Cong | Customee...| :i>>|=| . o Total PLLs 0/1(0%)
Task ~ oW Suppressed Messages UFM blacks 0/1(0%)
ADC blocks 0
L ~ I Compile Design
L > I Analysis & Synthesis
L > = Fitter (Place & Route)
L > I Assembler (Generate programming files)
L > I TimeQuest Timing Analysis
L > B+ EDA Netlist Writer
Hib Praneam Nevice (Onen Branrammer) A
< > < >
® 7310
2| al @I & |V < <Filter>>
n

‘Type ID

Message
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3.4 FPGA 1z

1. 8 micro-usb Z&#4 STEP-MAX10 AR P & 7% HE 22 Ha i USB 2 11, JEFEE 52 HH Tools
—Programmer &30 5% T EA:H Programmer 441, HEAFE AL .

€} Quartus |l 64-Bit - F/LED shining/LED_shining - LED _shining
Eile Edit View Project Assignments Processing Tools Window Help =2
|_1 E = ﬂ PRESE S W CRHT it Run Simulation Tool
» . N -
Project Navigator na Launch Simulation Library Compiler
a Launch Design Space Explorer I
A
[ Files 53 TimeQuest Timing Analyzer
bEd .
LED_shining. v Advisors
&  Chip Planner
My tierarchy  E]Files | of Desgnunits ¥, 4 &&  Design Partition Planner
= MNetlist Viewers
Tasks q1a -
Flow: | Compilation = | [customize B  SignalTap II Logic Analyzer
= In-System Memory Content Editor
Task
@ Logic Analyzer Interface Editor
v B Compile Design
Q{ o p L g_ _ @ In-System Sources and Probes Editor
= E SignalProbe Fins...
x o _D
ol |0 A& & |F <<Fiterss > e
ﬁn JTAG Chain Debugger
Type ID Messzage % Fault Injection Debugger
> Quartus II 64-Bit EDA System Debugging Tools
o \') 293000 Quartus IT Full Compil _
g, 1P Catalog
g Nios T1 Software Build Tools for Edlipse
=|\_System (1] Processing (136 - e
Opens a Programmer window i%' Osys

- O X
[Searchalleracom | @
" o =
o O e U e 90]a o @
1P Catalog nax|
Y I ERE) x| =
A v 2B Installed P -
n = 12mhz “ Project Directory
_n_in, active 1 Mo Selection Available
ucput ~ Library
proput > Basic Functions
> Bitec
0D = 12 000 000 > DSP
» Interface Protocols
> Memory Interfaces and Controllers
> Processors and Peripherals v
v
> o Add...
ﬁ Find Next
A
errors, 1 warning
17 warnings
v
>
100% 00:01:21

2. PRI R, #iAERS) N USB-Blaster[USB-0], i%4% Add File ¥ T2 4t SC -+
pof #3044, 213k Program FIAl Verify 51, siili Start #4147 FPGA %k,

Uk Programmer - F/LED shining/LED shining - LED shining - [Chain2.cdfl* — O ®
File Edit WView Processing Tools Window Help = @
_3. Hardware Setup. .. IUSB—BIasher [UsB-0] I Mode: | JTAG hd Progress: [ ]

[] Enable real-time ISP to allow background programming when available
T File Device Checksum Ugercode Program, Verify Blank- Examine
Configure Chedk
Fstop output_files/LED_shining.... 10M025CM153 00656495 00000000 O
CFMD ]
&l Auto Detect UFM U
. Delete
I (4 Add File... I g >
A
'f_,‘ Change File...
' save File
E} Add Device...
Hiup
JHiDown 10MO25CM153
TDO
4
v

3. FPGA N#E5Em, S Progress JRAS 78 100% (Successful). WEZEFF KIS .
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Uk Programmer - F/LED shining/LED shining - LED shining - [Chain2.cdfl* — O ®
File Edit View Processing Tools Window Help 57 @
I |
= Hardware Setup... |USB—BIasher [usB-0] | Mode: | ITAG hd Progress: [ 100% {Successful) -
[] Enable real-time ISP to allow background programming when available
W File Device Checksum Usgercode Program, Verify Blank- Examine
bt Start Configure Check
output_files/LED _shining.... 10MO2SCM153 00656435 00000000 O
M Stop
CFMD ]
&l Auto Detect UFM (]
. Delete
(4 Add File... g 2
"
(¥t Change File...
‘A Save File
[_‘f Add Device... DI
—
i up
JHiDown 10MO25CM153
TDO
4
v

4. {E T E Modelsim

1. HSEHREATHER IR SC: (Textbench): LED shining_tb.v, MRASCHFRERG IR

‘timescale 1ns / 100ps
module LED shining tb;
parameter CLK PERIOD = 40;

reg sys clk;

initial
sys clk = 1'b0;
always
sys_clk = #(CLK PERIOD/2) ~sys clk;

reg sys_rst _n; //active low
initial
begin
sys rst n =
#200;
sys rst n =
end

1'b0;

1'bl;

wire ledl,led2;

LED shining #

(

.CLK_ DIV PERIOD(4'd12)

)

LED shining uut

(

.clk _in(sys_clk), //clk in = 12mhz
.rst n in(sys rst n), //rst n in, active low
.ledl(ledl), //ledl output
.led2(led2) //led2 output
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endmodule

2. EFFE AL Assignments—Settings BX . EA“H Settings 44411,

BN BB .

&4 Quartus Il 64-Bit - Fy/LED_shining/LED_shining - LED_shining - m} *
Fie Edit View Project Assignments Processing Tools Window Help 5 @
DEd@ T Do VU KR QP LoD
* Settings... Ctrl+5hift+&
Project Navigator —= t - LED _shining [£J IP Catalog nEx|
Q, & Assignment Editor CHrl+shift-+A i@ —m Y x| =
® "
. Fin P, Ctrl-+Shift-+N [l
[ Files W PinFlanner ' Flow Status ~ | ¥ 2 Installed IP ~
B4 LED_shining.v Remove Assignments... ) Quartus IT “ Project Directory
{5 Back-Annotate Assignments... it Global Settings || |Revision Ne No Selection Available
Import Assignments... me Top-.leve\ 2 ~ Library
S Bry Family
iy Hierarchy Export Assignments... Devica Basic Functions
Tasks Assignment Groups... hhesi Timing Mod Bitec
eSS Total logic ¢ DsP
Flow: |Compilation 3 Logiclock Regions Window Alt+ Total o Interface Protocols
s Design Partitions Window Alt+0 DEd"_B Memary Interfaces and Controllers
T FOWEIFEY Fer Analyzer [oElEE] Processors and Peripherals
. . v
L' 4 ~ P Compile Design v [ TimeQuest Timing Analyzer v Total pins
- - R p
< > < > < > o Add...
x o _W
= Al Q & T A |¢ < <Filter = > &3 Find... ﬁﬁ Find Next
it
Type in Message ~
i 10905 Generated the EDA functional simulation files although EDA timing simulation option is chosen.
8 (i) 204019 Generated file LED shining.vo in folder "F:/LED_shining/simulation/modelsim/" for EDA simulation tool W
IS >
]
=\ _System (4 Processing (136
Change the Settings 100% 00:01:09

3. EFESEHEAE
HEH 57 New,

7 OK [ 2 i v FE i »

Simulation &1, L% Compile test bench, i Test Benches, 7E5# H X1
JH'5 Test bench name, %88 HZAMIECCHE, W S EARRINT, &5 5

Category:

General
Files
Libraries
~ 1P Settings
IP Catalog Search Locations
Design Templates
~ Operating Settings and Conditions
voltage
Temperature
~ Compilation Process Settings
Incremental Compilation
v EDA Tool Settings
D fv/Svpthesis
Formal Verification
Board-Level
~ Compiler Settings
WHDL Input
Verilog HDL Input
Default Parameters
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap II Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settings
SSN Analyzer z

4. EPEEHFE Tools—Run Simulation Tool—RTL Simulation %15

Spedify options for generating output files for use with other EDA tooks.

o

Device...

x

Tool name:  ModelSim

[] Run gateevel simulation automatically after compilation

EDA Netlist Writer settings

Format for output netiist: |Verilog HDL - Time scale: | 1ps

Output directory: | delsim

[ Map ilegal HDL characters
Options for Power Estimation

[ Enable gitch filtering

[] Generate Value Change Dump (VCD) file script | Seript Settings...

Design instance name:

More EDA Netiist Writsr Settings...
Nativelink settings
O MNone
amn\e test bench:
[] Use script to set up simulation:

() Script to complle test bench:

More Nativelink Settings. ..

Reset

—
x

Specify settings for each test bench.

Existing test bench settings:

Cancel

%51, Quartus B4 EH 35 5l Modelsim B4

Apply

Help

Hame TopLevel Module  Design Instance o
t...
Delete
< >
oK Cancel Help
_+" New Test Bench Settings x
Create new test bench settings.
Test bench name: | LED_shining_tb | 3 |
Top level module in test bench: [LED_shining | |
[] Use test bench to perform VHDL timing simulation
Design instance name in test bench: NA
simulation period
(@ Run simulation unti all vector stimuli are used
() End simulation at: s v
Testbench and simulation fles .
LED_shining_tb.v
Up
Down
Properties...
oK Cancel Help

¢ T EA%H RTL Simulation
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&4 Quartus 11 64-Bit - F:/LED_shining/LED_shining - LED_shining - O x
File Edit View Project Assignments Prooessl/'n%' Tools | Window Help 5 @
DS @ 4 B 9 o [ RinSmisioniol i AT Simiation 1IEHEE P
Proiect Navidator ng #.  Launch Simulation Library Compiler ,3: Gate Level Simulation. .. 1ax|
Launch Design Space Explorer I .
Q, s E) x| =
[ Files 'G} TimeQuest Timing Analyzer - ‘% Installed P o
LED_shining. v Advisors v [Quertsl * Project Directory
HERS No Selection Available
@ Chip Planner Top-evel E v Library
= = . " Famik
/% Hierarchy @ Files " Design Units ‘o 4 % Design Partition Planner Devi:e *» Basic Functions
@ ig Metlist Viewers * |Timing Mod S Bitec
. § i Total logic ¢ > DSP
Flow: Compilation ~ | | Customize SignalTap I Logic Analyzer Total o . Interface Protocos
& In-System Memory Content Editor i
g K Dedu.a > Memory Interfaces and Controllers
|ﬂ Logic Analyzer Interface Editor s > Processors and Peripherals
~ = v
@ In-System Sources and Probes Editor Iof! Dmf v
- Wl 5 B Add...
g v SignalProbe Pins. .. i v il
x 9 o Programmer
s a8 |5 A |La |T c<Fiters> W Prog 4 Find Next
1 ﬂﬂ ITAG Chain Debugger
Type ID Meszzage % Fault Injection Debugger ]
i 10905 Generated the EDAE func System Debugging Tools » P EDZ timing simuwlation option is chosen.
8 \Q 204019 Generated file LED shi Rg/simulation/modelsim/"™ for EDA simulation tool W
gl < @l P Catalog >
]
=|%_System (4 Processing (138 Mios 11 Software Build Toals for Edipse
Rung the specified RTL simulation tool A asys 100%: 00:01:09
. — — o, > sy
5. Modelsim #5305 H 3 5e US4 16, FHiman T 1&.
M ModelSim SE-64 10.1¢ - O X

File Edit View Compile Simulate Add Structure Tools Layout Bookmarks Window Help

B-s O-ME |l B S

BE tew U et unnEe gy | tort e |
ColumnLayout |A11CDlu.mns J H = R R N R | H |— |— |— sun| J K ﬂ @
$a Objects H x|
'11r1513r1ce ‘_lDEsign unit '1Narr|e |Va|ua ||Gﬂd |Mude "
=+l LED_shining_tb LED_shining ’ CLK_DIV_PERIOD 1100 Para... Internal
:Hil altera_Insim_ver = ED g ED g
j—m altera_mf_ver ) #ASSIGN#15  LED_shining
j—m altera_ver ) #ASSIGN#14  LED_shining
ﬂ—m fiftyfivenm_ver b ) =ALWAYS#19  LED_shining
(=4l o _ver @ =INITIAL#13 LED _shining
(=4, sgate _ver & #FINITIALET LED_shining| I+
(x4 ri_wark @ FALWAYS#HS LED_shining
[+l floatfixiib |’ #vsim_capacitys |# Processes (Active) H A
(=l machxo2 MName Type (filtered) AE |
L e G femnh - + sassianzEa Assinn -
| | | 1 v | 4] | v | 4]

f-} Transcript R

# run -all

[Now: 3,661,642,920 s Delta: 0 [sim: \LED_shining_tb/LED_shining_uut | [ |keen| o] y

5. EHFEFEMNEWNGE S, adihsd, Rt rA e R Es: Add Wave, IXFE U
NAE SGIINE Wave & H .

I vibrary —s—H A X @sjm-Defﬁult— —— Hd = *(lgu:ls H e x|
'1Name = ﬂlnsmnce \_|Design unit "IName |'\¢'alue ||Gr1d |Mode
¢Hll work =4 LED_shining_th LED_shining « CLK_DIV_PERIOD 1100 Para... Internal
[+l attera_nsim_ver - LED_shining_uut  LED_shining & dk_in St Met In
[zl attera_mf_ver & #ASSIGN#15  LED_shining 4 rst_n_in St Met In
(=4l altera_ver ) #ASSIGN#14  LED_shining View Dedaration t
ﬂ—m fiftyfivenm_ver & #ALWAYS#19 LED_shining e e t
(x4l tom_ver & =INITIAL#13 LED_shining
[+l soate_ver & EINITIALET LED_shining Add Wave Crl+w
(el rd_work - = ] #ALWAYS#9 LED_shining Add Wave New
ﬂ—m floatfixib le. #ysim_capacity # T ’
[#Hli, machxo2

Wl me? lih femntd d Add Dataflow Cl+D
ll | ] [N 3 | [ 8 [ [ add to 3

. P Wave B R, &P T EHALT Restart #7241, FE#A ) Restart B M S oK, &
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i E Wave & [,

=

File Edit View Add Format Tools Bookmarks Window Help

| Wave - Default i o o] x|
B-sE 8 rka0Y  NE|| S QN || oy tes [B et

a-q-g6-3

|aaean

A EE e Frrjtatigas
b sec: [ ] g 8 ‘ M Restart X

List Format
5*"‘9 thfrst n_in Wave Format
Breakpaints
- Logged Signals
5*"‘9 I-I-IYJ"* div Virtual Definitions
_shining_uut/ent Assertions
Cover Directives
ATV Format

» I

I\ 2507 ps to 4073 ps | 1LED_shining_tb LED_shining_uuit/CLK_DIV_PERIOD

7. B T HEA R E ], A T EAS S Run 4241, BHTORE, RN, 15 B 5K,
B Wave — [m] x
File Edit View Add Format Tools Bookmarks Window Help

pm| Wave - Default ] SIS

5-EH S SRR 0-AE| SERR|| o tes H modd]umAe | 9w
3-4-G B3
N4l | EL e s TN
ARt S I TR

E Msgs

|tatitaas

JQQQQ%

#  LED_shining_tb/LED_shining_uut/CLK_DIV_PERICD |12 17
JLED _shining_tb/LED_shining_uut/dk_in St1
JLED_shining_tb/LED_shining_uut/rst_n_in St1 |
/LED_shining_th/LED_shining_uut/ent 5 0 s Te Y47 Js Jo YDA T 2 YEA 15 5 17 B[ Jo[u 1 s 1
JLED _shining_th/LED _shining_uutfdk_div 1]
. LED_s _th/LED_shining_uut/led 1 S0
#a JLED_shining_tb/LED_shining_uut/led2

r“@me Mow |00 ps
e Cursor 1 |795 ps

[<] 3 I I

[ 0ps to 1357873 ps [ 1.ED_shining_tb/LED_shining_uut/CLK_DIV_PERIOD

5. hA

I

[ [@

A S B H Bk
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